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1 Introduction

The SX1211 is a single chip transceiver IC designed for operation in the European 868 MHz and U.S. 915 MHz
licence free ISM bands. The SX1211 is optimized for very low power consumption (3mA in receiver mode). It
incorporates a baseband modem with data rates up to 200 kb/s. Data handling features include a sixty-four byte
FIFO, packet handling, automatic CRC generation and data whitening. lts highly integrated architecture allows for
minimum external component count whilst maintaining design flexibility. All major RF communication parameters are
programmable and most of them may be dynamically set.

The SX1211SKA is a USB evaluation tool designed to allow simple and easy evaluation of the suitability of the

SX1211 for a given application. The low component count reference design implemented in the SX1211SKA is
shown below:
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Figure 1. SX1211 Application Circuit

The SX1211 main features include:

» Low Rx power consumption: 3mA

> Low Tx power consumption: 25 mA @ +10 dBm

» Good reception sensitivity: down to -107 dBm at 25 kb/s in FSK, -113 dBm at 2kb/s in OOK

» Programmable RF output power: up to +12.5 dBm in 8 steps

» Packet handling feature with data whitening and automatic CRC generation

> Wide RSSI (Received Signal Strength Indicator) dynamic range, 70dB from Rx noise floor

» Bit rates up to 200 kb/s, NRZ coding

> On-chip frequency synthesizer

» FSKand OOK modulation

» Incoming sync word recognition

> Built-in Bit-Synchronizer for incoming data and clock synchronization and recovery
Revision 0.1 March 2009 © 2009 Semtech Corp. www.semtech.com
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2 Getting Started

2.1 Kit Contents
As illustrated in the figure below, the SX1230-11SKA Evaluation kit is composed of:

>
>

A pair of SX1211SKA boards
SX1211-11SKA CDROM including all necessary PC software and documentation

ram
Vi
SEMTECH

DEVELOPMENT | tools

Figure 2. SX1211SKA Contents

2.2 Installation

SX1211SKA Advanced Mode Software Installation

1-
2.

Put the CDROM in your computer and browse the contents of the CD.

Open the “sx1211starterkitsetupweb.exe” manually. It can be found in the \Installers sub directory of the
CD-ROM.

Follow installation guidelines until the process is completed. Please note that .NET Framework 2.0 and the
FTDI USB driver will be automatically installed if not detected on your computer.

Connect the SX1211SKA board to the PC via the USB interface.

Launch “SX1211SKA” from the Start menu.

Click on “Connect” button in toolbar or in File menu.

SX1211SKA is now installed and ready to be used.

Revision 0.1 March 2009 © 2009 Semtech Corp. www.semtech.com



z SEMTECH User’s Guide

SX1211-11SKA

ADVANCED COMMUNICATIONS & SENSING

2.3 SX1211SKA Overview

The SX1211SKA features the SX1211 reference design (1) and is also interfaced via an FTDI bridge (6) to the USB
type ‘A’ interface (5) of a host PC. Indication of transmission and reception is indicated on a pair of LEDs (4). A
Johanson Technologies ceramic antenna is employed (2) and optional provision for an SMA connector (not
populated) is provided for laboratory testing.

Figure 3. SX1211SKA Board Picture

Revision 0.1 March 2009 © 2009 Semtech Corp. www.semtech.com
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3 AQuick Start Guide

With the SX1211SKA software installed, follow the sequence below to establish communication between the one
SX1211SKA as transmitter and one SX1211SKA as receiver.

3.1 SX1211SKA Quick Start (All Modes)
1. Plug the SX1211SKA into the USB port of the computer.

2. Runthe SX1211 User Interface software Start > All Programs > SX1211SKA > SX1211SKA

3. The SX1211SKA should connect automatically to the User Interface :
Software. If not, then click on the USB connect short-cut button, located in < B
the top left hand corner of the window.

4. Once connected the SX1211SKA shows the default configuration of the SX1211 register settings
upon power-up.

R
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Figure 4. SX1211 User Interface, Default Settings

5. Once connected the SX1211SKA shows the default configuration of the SX1211 register settings
upon power-up (as shown in Figure 4).
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File

Help

6. The settings for communication between transceiver kits are located on the
installation CD-ROM provided with the kit. Use the File > Open from the menu - (o | <=
bar, or the open short-cut button to load a configuration file.

7. Load the “XXX_SX1211_pingpong.cfg” file from the “SX1211 Demo Files” folder on the CD-ROM.
Where XXX corresponds to the frequency band of the SX1211SKA (either 868 or 915 MHz).

8. The display will then appear as shown in Figure 5.
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Figure 5. The New SX1211 Configuration: Ready to be Written

should remain unchanged.
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3.2 SX1211SKA Receive Mode Configuration
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1. Click on the ‘Packet’ tab to access the packet testing portion of the program. Within this window a pre-
defined packet structure is already configured. It remains simply to click the ‘Reception’ radio button and
press the Start button. At this point the SX1211SKA enters packet receive mode and is now listening for
valid packets. At this juncture another SX1211SKA must be configured as transmitter.
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Figure 6. The SX1211SKA User Interface whilst in Packet Receiver Mode
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3.3 SX1211SKA Transmit Mode Configuration
1. Repeat steps 1 to 9 of Section 3.1 with the second SX1211SKA provided in the kit. Then click on

the ‘Packet’ tab.

2. The packet test display is preconfigured in transmit mode with a valid payload (see Figure 7). The
‘Repeat value’ may be edited according to the number of packets desired to be transmitted (leave
equal to zero for continuous transmission).

. y g . . .

3. Press the Start button. Packets will start to be sent, the “Tx Packets’ display indicating the number
of packets sent.

4. The successful reception of packets will be indicated in the ‘Rx packets’ window of the receiver
SX1211SKA.
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Figure 7. The SX1211SKA User Interface Ready to Transmit the Demonstration Packet
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4 SX1211SXA Software Description

4.1 Overview

Figure 8 shows the SX1211SKA graphical user interface. Each of the numbers surrounding the display corresponds
to the Chapter within this section which corresponds to the description of that GUI feature.
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Figure 8. SX1211SKA GUI Overview and References to the User Guide Description of this Chapter

4.2 File Menu

| Fie | Hep File menu contains some general purpose functions. Some of them can also be accessed
[ Disconnect | on the toolbar by clicking directly on the icon. The first feature in the list provides the
possibility of connecting or disconnecting to the USB kit. Care must be taken to ensure that
[ OpenCorfig... the USB port is closed before removing the USB kit. This functionality may also be
e Save Config accessed through the short cut buttons (see Section 4.3).
@ Save Config As... . . )
The possibility of opening configuration files and saving the present configuration is also
Exit provided. This is done through a standard Windows file dialog box.

. File | Help
The Help menu contains two menu items. The first item provides a link ——
to this user guide in PDF format. The second, About SX1230 Starter & o Jesis Gl

kit..., gives information in the revision of the software installed. ‘Earel 5L About 541230 Starter K.

Revision 0.1 March 2009 © 2009 Semtech Corp. www.semtech.com
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4.3 Shortcut Buttons

The shortcut buttons provide identical functionality to those listed under the file menu

=
2

s

The configuration file open shortcut button. This opens a windows file dialog box to allow access to
previously saved SX1211 register configuration files.

The save configuration file shortcut button immediately saves and overwrites the existing
configuration file.

The connect / disconnect button allows the user to manage manually connection and
disconnection of the kit. Note that any time the SX1211SKA is to be removed from the system; the
kit must first be disconnected.

The saved configuration files are designed to be a useful tool for embedded software development. The file can be
opened in any text editor to display the programmed register name, address and hexadecimal value programmed to

that address.

—Iol x|
File Edit Format Wiew Help
#Register Mame Address [Hex] value[Hex] ;|
RegMcParaml 0x00 0x70
RegMcParams2 0x0l OxBC
RegFDev 0x02 0x07
RegEitRate 0x03 0x07
regookFloorThres Ox04 Ox0C
RegMcParama Ox05 OxCF
Regrl 0x06 0x7D
RegPl 0x07 Ox6d
Regsl 0x08 Ox14
Regr2 0x09 Ox74
Regp2 Ox0A Ox62
Regs2 0x0B Ox32
RegParamp Qx0C 0x38
RegIrgParanml 0x0D 0x08
RegIrgParam? 0x0E Ox1F
RegrssiIrgThres Ox0F 0x00
RegRxParaml 0x10 OxA3
RegRxParams2 0x11 0x38
RegRxParams Oxl2 Oxl8
Regres19 0x13 0x07
Regrssivalue Ox14 0x1E
RegRxParama 0x15 0x00
RegsyncBytel 0x16 Oxah
RegsSyncBytel 0x17 Ox0A
RegsyncByT es 0x18 0x0B
RegqsyncByted Ox19 Ox0C
RegTxParam OxlA Ox72
RegoscParam 0x1E OxBC
RegPktParaml 0x1c 0x02
reghodeaddr 0x1D 0x00
RegPktParams 0x1E 0xE0
rRegPktParamd Ox1F faxco
FET True;False; 2;0:48,49
[

Figure 9. Example Text Editor Output of the SX1211 Configuration File

Revision 0.1 March 2009 © 2009 Semtech Corp. www.semtech.com
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4.4 Text Field Conventions for the SX1211SKA

An orange background highlight indicates that the precise

_ value entered into the data entry field is not directly

RF frequency: I 15000001 Hz  agdressable by the SX1211. Instead the closest
(rounded) value will be used.

Conversely a red background highlight indicates where

FF frequency: I 1915000000 H- the maximum or minimum value for that register
' parameter has been exceeded.

4.5 McParam Tab

Band Selection
One of the three operating bands for the SX1211 may be selected
Band: |E|15-E|2E= 'I tMHz  here. The SX1211SKA hardware is band specific and so the
corresponding band should be selected.

VCO Voltage Trim

In some designs the VCO voltage requires trimming. The
I':' :Iv m SX1211SKA reference design does not require this function, but is

included here for completeness.

WCO brim:

Modulation Selection

_ & ~ The SX1211 is capable of both FSK and OOK modulation, they are
Modulation scheme: * Fsk 0ok selectable through the user interface by clicking with the mouse on
the appropriate radio button.

OOK Receiver Detection Type

Several modes of OOK detection are possible, please see the

O0F. thres type: IF'eak vI SX1211 datasheet for mode information on configuring the OOK
receiver.

Data Mode

Three data modes are available for the SX1211, typically packet
Data miode; IEnntinunus 'I mode is selected automatically, requiring no user selection, upon
launching the Packet Test (see Section 4.13).

Gain of the IF Stage

. The gain of the intermediate frequency amplifier chain can be
IF gair: I':' M adjusted manually.
Revision 0.1 March 2009 © 2009 Semtech Corp. www.semtech.com
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Frequency Deviation

Fdew: |1 aoono Hz
Bit Rate
Biitrate: IEEEII:IEI bps

Floor Threshold for OOK Detection

00k, floor thres: E.0 = dE

FIFO Settings

FIFD size: 16 | bytes
FIFD thres: 15 -

PA Ramping
P, ramp: 23 | uz

Frequency of Operation

T arget RF frequency:

IE!'I 5000000 Hz

" 1 o2
R | E 115
P | 100 95
g | — 50 50

Revision 0.1 March 2009 © 2009 Semtech Corp.

Text entry field for the frequency deviation when using FSK
modulation.

The bit rate of the transmitted signal (in bps) can be directly edited
in this data entry field.

Margin to the OOK demodulation threshold — see SX1211
datasheet for more details.

Both the working size of the FIFO and the number of bytes it must
store before generating a hardware interrupt are user defined.
Again this functionality is largely automated in the packet test
mode (Section 4.13).

The PA ramp rise time is selectable from the list of programmable
values.

The frequency of operation of the SX1211 is a set by three
frequency divider ratios (see Figure 10). Based upon the frequency
of the crystal oscillator and the values of these divider ratios the
local oscillator frequency may be determined.

To simplify this process, the SX1211SKA user interface sees this
process completely automated. By entering the desired operating
frequency in the text field at the top of the display, the resultant R,
P and S divider ratios are calculated (see the SX1211 datasheet
for information on their calculation).

www.semtech.com
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Figure 10. SX1211 Local Oscillator Generation
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4.6 Overview Panel

A summary of the values presently entered into the user interface software is shown in the overview display at the
bottom of the screen. This is sub-divided into three sections pertaining to: general configuration, transmitter settings
and receiver parameters.

General Rx
B and: 915-928 | MHz | Passive filter fo: 378000 | Hz
RF frequency: 915000000 | Hz Butterworth fo-fo: 100000 | Hz
kadulation scheme: F5K Folyphasze fo; r 100000 | Hz
Frequency D eviation: 100000 | Hz Tx
Bitrate: 25000 | bp: || Interpaolator filker Fe: 200000 | Hz
O perating mode; STANDBY Clutput power; 10 | dBm

Figure 11. The Overview Panel

4.7 Register Hexadecimal Display

Figure 12 shows the register summary of the SX1211. In addition to manual user entry in the fields described in the
previous section, direct hexadecimal entries may be made into the register display. Note that values yet to be written
to the SX1211 registers appear in red. Note, also, that for full control flexibility, incorrect (red) values entered in the
hexadecimal section will still be written in the event of a register ‘write’. So care must be exercised when editing the
hexadecimal values.

Revision 0.1 March 2009 © 2009 Semtech Corp. www.semtech.com
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Register Addr | Yalue Register Addr | Yalue
RegMcParaml 0=00 =23 RegRxParaml 010 | O0=43
RegMcParam2 0=01 =33 RegRxParam2 =11 (=33
RegFDev 0x02 | 0=02 || BegRxParam3 012 | 0«12
RegBitR ate 0:03 | 007 || RegRes19 013 || 0=07
RBegOokFloorThres | 0:04 | 0=0C RegRzsi¥alue 14 (=00
RegMcParamb 0:05 | O=0F || BegRxParamb 015 || 0=00
RegR1 0x06 | 0=5F || RegSyncBytel 016 || O=00
RegP1 0:07 | 0279 || RegSyncByte? 017 || 0«00
RegS1 0z08 | 0«14 || RegSyncByte3 018 | O=00
RegR2 0x09 | O=74 || RegSyncByted 019 || 0«00
RegP2 [, =52 RegTxParam O=14 =72
RegS52 0z0E | 0232 || BegDscParam 0«18 | O=BC
RegParamP O=0C (=33 RegPktParaml 0=1C Q=00
ReglrgParaml 0«00 | 0O=00 R egNodeAddr 0«10 | 0Ox00
RegligParam?2 0z0E | 0=09 || BegPktParam3 0<1E || O=42
RegRssiligThres 0:<0F | O=00 R egPktParam4 Ox1F | 0O=00

Figure 12. The Hexadecimal Register Display Summary

4.8 The Mode Control Box

The mode control box is sub-divided into three sections. The first ‘Operating mode’ allows the user to change the
operating mode of the SX1211 by clicking on the radio button corresponding to the desired mode. Note that the
transition between modes is instantaneous. The centre section, ‘Registers config’ allows the register settings
entered elsewhere in the user interface to be written to the configuration registers of the SX1211 by clicking the
write button. The read operation will read the configuration registers and refresh the user interface display with the
values read from the SX1211.

— Caontral

—Operatingmode ——— | 7 Reaisters config————] —R55|

| 0 &
{*  Standhy " Synthesizer Fead
Fead |

" Feceiver ' Transmitter Flasat

® Wafrike

il

Figure 13. The Mode Control Box also Incorporates RSSI

The third, rightmost, section of the mode control box allows an instantaneous RSSI (received signal strength
indicator) measurement. Please note that this feature is only accessible when the SX1211 is in the receiver
operating mode.

Revision 0.1 March 2009 © 2009 Semtech Corp. www.semtech.com
16



SX1211-11SKA

ADVANCED COMMUNICATIONS & SENSING
4.9 The IrgqParam Tab

z SEMTEGH User’s Guide

Fiw Standby (RG_0: ISynu: "I PLL lack an pin 23: f* Ye: Mo
Fix Standby IRGE_1: IDELK "l RS51 [rg Threshold: IEI
T=IRO_T1: IDELK VI

FIFD full i

FIFO ermpty: =

FIFD overrur: " ] Clear |

FIFD fill method: & Aute 0 Manual

FIFQ fill: - | Clear |

Tu done: " ]

Tw Start IRQ_O: = FIFD Tikreshold €0 FIFD Hat empty
RSSI Irg: " ] Clear

e

PLL lack: " ] Clear

Figure 14. The Interrupt Mapping Display

For total register coverage by the user interface, the interrupt mapping for the SX1211 can be controlled through the
configuration of the IrgParam display. Note, however, that the hardware interrupt feature is not used directly by the
GUI. For further information please see the corresponding register descriptions in the SX1211 datasheet and the
PCB layout and schematics of Section 5.

4.10 The RxParam Tab

The receiver parameter field provides full access to all of the software configurable settings of the SX1211. For
reference, a simplified block schematic of the SX1211 receiver is shown in figure Figure 15. The settings
configurable in the receiver parameter tab correspond to the programmable baseband receiver functions.

| First down Sacond down
coniersion conversion

W

ey

RF IF1 Baseband, IF2 in OOK

|+,

I

Figure 15. SX1211 Receiver Block Diagram, the Colours Correspond to the Frequency of Operation.

Revision 0.1 March 2009 © 2009 Semtech Corp. www.semtech.com
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Rx passive filter [fc]; IS?BDDD vI Hz
R buttenwarth filker [fo-fal: I'IEIEIEIEIEI "’I Hz
Fix polyphaze filker [fo]: I‘IDDDDD vI Hz

FPalyphaze filker: € O & OFF

Bit gynchronizer: f OM  OFF e

Sync word recognition:  0OM ¢ OFF Sync word size [1-4]: m
Sync word tolerance: m errar Byte[1] | Byte[?] | Byte[3] | Byte[4]
BSS | Value: ID— =00 =00 =00 =00
O0F. threzhold step: (IR3] | dB

00K threshold dec peniod: I‘l per chip "I periods
QO0OK. avg threshold cutaff: IBitrate AEFI vI

Figure 16. Receiver Parameter Display

For a complete description of the functionality of the receiver section please consult the SX121 datasheet. However,
the principle fields of interest for general use are:

Rx Filters:
The first three text entry fields of the receiver parameters correspond to the baseband filtering section. Note that the
Butterworth filter is the narrowest of the three filters and determines the receiver channel bandwidth.

Bit Synchroniser:

This block performs timing recovery and synchronises the decision on whether a given bit is logical high or low
based upon the received bit stream. This block yields a substantial improvement in receiver sensitivity performance
and it is hence recommended that it be left enabled.

Sync Word:

The synchronisation word is applicable to operation in buffered and packet modes. For packet mode operation the
sync word is set using the packet editor — this may be found in the ‘Packet’ Tab (Section 4.13). Link testing by the
SX1211SKA is done in packet mode only — sync word provision is made here for completeness.

OOK Settings:

OOK demodulation is based upon measurements from the RSSI block and there are a rich variety of settings for
how the OOK signal is detected and processed. These techniques and the corresponding settings are given a
detailed treatment in the SX1211 datasheet.

Revision 0.1 March 2009 © 2009 Semtech Corp. www.semtech.com
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4.11 The TxParam Tab

The transmitter configuration of the SX1211 is shown in Figure 17. This shows that the modulating signal is
generated by direct digital synthesis (DDS), unconverted through the superheterodyne mixer stages and then
amplified by a power amplifier chain.

| Arhpliﬁl:ali?nn | t $omnd First up-convarsion Interpolation e
P DL T dp-Conversion ﬁ mers ] e
7 | @1? % ‘@_ ; ll——— Data
Y LO2T
2
- |l oK
—X 2e
a | :
L/ ! Q
RF IF Baseband

Figure 17. SX1211 Simplified Transmitter Block Schematic Diagram

| DzcParam I Packet I

T interpolator filter: I 200000 - l Hz

Output powwer: 10 | db

Figure 18. The Transmitter Parameter Tab Display

The two parameters which are configurable for transmit operation of the SX121 are:

Output Power:

The output power of the SX1211 can be programmed in 3 dB steps. Valid programmable powers are selected from
a drop-down list of valid values.

Interpolation Filter Setting:
The DDS output requires filtering to remove the spurii common in the generation of signals through this technique;
this is performed by the interpolation filters. The cut-off frequency of the interpolation filters can be selected from the

drop down menu of valid values. The technique for calculating the cut-off frequency may be found in the SX1211
datasheet.

Revision 0.1 March 2009 © 2009 Semtech Corp. www.semtech.com
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4.12The OscParam Tab

HTAL frequency: |1 2800000 Hz

CLE out; = 0OM  OFF

CLE. out frequency: |42EEEE Hz

Figure 19. The Oscillator Parameter Display

The oscillator parameter display gives access to the clock output functionality. This can be enabled or disabled and
the frequency changed by entering a value in the ‘CLK out frequency’ text field. Note also that there is provision to
change the frequency of the crystal. Changing of the crystal frequency has a knock on effect on all parameters that
are a function of the reference frequency, for example bit rate, filter settings, RF output frequency. The SX1211SKA
is fitted with the 12.8 MHz crystal recommended in the SX1211 reference design. For this reason the crystal value
should, typically, be left unchanged.

4.13 The Packet Test Tab

The ‘Packet’ tab is the principle interface for conducting transmission or reception testing. The display, as shown in
Figure 18 is divided into three horizontal portions. The top portion of the display is given to the packet editor. Here
the configuration of the packet, either to be transmitted or received by the SX1211SKA is constructed.

The packet layout contains all of the features described in the SX1211 datasheet. This includes:

Preamble
This input allows the user enable and set the length of a pulse train preamble (sent at the data rate).

Sync word size
A custom syncronisation word of up to 4 bytes may also be added.

Sync tol
The number of errors which may be accommodated in the sync word (bits), before the packet is rejected.

Format / Length / Address
Fixed or variable length packets may also be stipulated (see the SX1211 datasheet for more information), as may
an optional 1 byte address.

Digital Coding
Optional channel coding including CRC, data whitening and Manchester coding are also available.

With these options entered the constructed packet is shown in the ‘Packet’ frame. Where the SX1211SKA is to be
used in transmit mode, the packet payload may also be edited in either ASCII or hexadecimal. Packet transmission
is enabled by selecting the ‘“Transmission’ radio button. This starts when the ‘Start’ button is pressed. Either infinite
transmission (repeat value = 0) or a finite number of packets may be transmitted by editing the repeat value.

Revision 0.1 March 2009 © 2009 Semtech Corp. www.semtech.com
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Mu:F'aramI Iqu'aramI H:-:F'araml T:-:F'araml OscParam  Packet |

— Packet configuration
Preamble | Sync zize | Sync tol | Format Addrezs Field DC free CRC
Fived =
- e J ; ™ Manchester | CRC
4 bytes j 4 bytes j 0 bit j Length [T Addin FPayload o
I YW hitening
0x02
— Packet
Preamble Sync Length Address Meszage CRC
Ah-BR-55-55 Q0-00-00-00
— Meszage
HEXADECIMAL ASCI
48 49 HI ﬂ
£ Tranzmition { Feception Start |Hepeat wvalle; I 0 TuPackets:

Figure 20. The Packet Receiver / Transmitter Test Display

For receive mode, the normal mode of operation in conjunction with the SX1230SKA, the reception the ‘Reception’
radio button is selected and the start button pressed. From this moment the SX1211 is placed in receive mode and
listens continuously for a packet corresponding to the format entered in the packet editor. Upon successful
reception, the payload received is shown in the ‘Message Box’ and the number of received packets is incremented.
For indication of the signal strength received by the SX1211SKA, the RSSI display (see Section 4.8) is activated

and continuously refreshed.

By way of example, Figure 21 shows the entire user interface display whilst receiving a valid packet payload.

Revision 0.1 March 2009 © 2009 Semtech Corp.

21

www.semtech.com



SX1211-11SKA

VANCED COMMUNICATIONS & SENSING

' SEMTECH User’s Guide

el
Filz - Help
(S d | .
Mc_F'aramI Iqu;aramI 1:“"F!‘E"E"'“I T:-:F'araml OsgParam  Packst | Register Addr | Value Register Addr | ¥alue
[ Packet configuration ReaMcParam] ;00 | 0480 || AegR¥Param Ot | Dua2
Preamble [Spne size | Syne tol | Format Address Filter DC free CRC RegMcParam? 0:01 | 0:8C || RegRxParam2 i R
Fised = RegFDev 0«02 | 0<07 || RegRxParam3 0x12 | 0«18
= 2 J T #anchess [T cRE - 5 i —
4 bhtes _I 4 bytes _I obit || Length |OFF =l e = RegBitR ate 0«03 | 0:07 || AegRes1a 0413 | Ox07
- e hitering [T At Clear
0RO RegOokFloorThees | 0:04 | 040C || RegRssi¥alue Ox1d | OxTA
o RegMcParamb 0405 | O=CF ReqRxParamb 0415 | (=00
[~ Fackel
HegR1 0z06 | 0:7D || RegSyncBytel OxlE J Cetdy
Preamble — ;:rnl; — Length Address Meszage CRC RegP1 P e RegSyncByte? w7 T oe
55-55-55-R5 ~La-DE-
Reg51 Ox08 | DxdE AegSyncByted Ot | Ox0B
) _________———————____— e ———— =
— Mezzage Hegh2 0x09 | Owdd RegSyncByled Bxt9 | Ox0C
HEXADECIMAL ASCIH RegP2 0x08 | D62 || RegTxParam Ou1a | O=72
e s ;I Reg&2 (08 | =32 HeglscParam 018 | O=BC
RegParamP [x0C D38 RegPkiParaml 01C [0z
LI RealigParami 000 | -B=08 ReglodeAddr 00 (=00
RegligParam2 (=0E | Bs1F RegPkiParam3 Ox1E [wif
€ Tiarsrition €% Recept : Rix packets: 128
SR Bl nEREE RegRssiligThies 0z0F | 0:00 (| RegPktParamd Ox1F | 'OxCO
Eleneml ' " Ra ' - Contral
Band: 902-915 | MHz || Passive filter fc: 378000 | Hz Operating mode ——————— 1~ Reistets canfi —————— —RSS!
RF frequency: 308000000 | Hz Buttenwarth fo-fo: 100000 | Hz o
= = § = T Slesn LI £ e
Modulation scheme: FSK Foluphase fo: I 100000 | Hz I 132° @
Frequency Deviation: 50000 | Hz Tx ) Stardby ) Burthesizer Fead | —
Bitrate: 25000 | bps || Interpolator filter fe: 200000 | Hz %) Hecewer 10 Tramsrmitter ot | _l
Dperatiﬁg mode: RECEIVER Output power: 10 | dBm
. | Config File: 915_521211_pingpanad.cfg
Figure 21. Software Display: Successful Packet Mode Reception
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5 Schematics and 2-Layer PCB Layout: SX1211SKA

; S
z -
g Zl wl] ©
- 3 -
o 2 gl ©
> £l S| e
SRS . w5
3 “‘|’ 22 al 2
: = ol o] 9k
g
L < mJi
=| @ S
- 1
| 2] ©
>
n |z At

fr—
DESCRIF
-3

PROJET

B

eunis

=i
CUIvRE

ON

MODIFICATI

AUTEUR

LES INFORMATIONS COMNTENUES DANS CE DOCUMENT SONT LA PROPRIETE EXCLUSIVE DE ADEUNIS R.F. ET NE PEUVENT ETRE REFRODUITES. UTILISEES OU

DIVULGUEES A DES TIEARS OUELS OU'ILS SOIENT SANS SON ACCORD ECRIT.

DATE

FoieesaT g

I
1

A |12/89-72088]  JAF  |CAEATION

T
RLMLE482
. 2K
T3]
1 s
[= .1
R
FHHEN
&
WHEN

I
|

1E

Sl of of
[ ‘:+

]i
;

UISE-4 -A1-MC-CH5

Revision 0.1 March 2009 © 2009 Semtech Corp. www.semtech.com
23



User’s Guide

SX1211-11SKA

23245587}22'

Cooroorooooooo

www.semtech.com

=
— =
B =T
L
5 0
m -
0677 wn|  Sgicd
c82] 7= oopz] o
0 —
0z o Q)

~ _Ye= | = £22
M n 02 == <51222
QO ~ 122 9z4
o) 28 | |8 G
=an =L T=
o
£33
= o W
- y B B
S e e
T =) 2 b=
7 ail 00 Fe1 oo
3 iy S mE= 2 E D)
0 L N0F] SMoe
5 I
= S ) N I
<
O
5
= L1 [
=
o
(&)
)
w
o
2
<
>
)
<

z SEMTECH

24

Revision 0.1 March 2009 © 2009 Semtech Corp.



z SEMTECH User’s Guide

SX1211-11SKA

ADVANCED COMMUNICATIONS & SENSING

6 References
» [1]1 SX1211 Datasheet

Revision 0.1 March 2009 © 2009 Semtech Corp. www.semtech.com
25



	Contact us
	1 Introduction
	2  Getting Started
	2.1 Kit Contents
	2.2 Installation
	2.3 SX1211SKA Overview

	3 Quick Start Guide
	3.1 SX1211SKA Quick Start (All Modes)
	3.2 SX1211SKA Receive Mode Configuration
	3.3 SX1211SKA Transmit Mode Configuration

	4  SX1211SXA Software Description
	4.1 Overview
	4.2 File Menu
	4.3 Shortcut Buttons
	4.4 Text Field Conventions for the SX1211SKA
	4.5 McParam Tab
	4.6 Overview Panel
	4.7 Register Hexadecimal Display
	4.8 The Mode Control Box
	4.9 The IrqParam Tab
	4.10 The RxParam Tab
	4.11  The TxParam Tab
	4.12 The OscParam Tab
	4.13  The Packet Test Tab

	5 Schematics and 2-Layer PCB Layout: SX1211SKA

